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Trademarks

Microsoft is a U.S. registered trademark of Microsoft Corporation.

Windows, Windows Vista, Windows 7, Windows 8, and Windows 10
are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Energy Star® is a registered trademark of the U.S. government.

IBM, IBM PC are registered trademarks of International Business
Machines Corp.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language,
in any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual, or otherwise, without the prior written
permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright
laws, the customer is solely responsible for complying with all
such laws and regulations.

Warranty

The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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Federal Communications Commission (FCC) compliance
information statement
Part 15

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one of the
following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and
receiver.

e Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

e Consult the dealer or an experienced radio/ TV technician
for help.

This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause
undesired operation.



https://manualsfile.com

User’s Manual

C€

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU
Directives:

® Low Voltage Directive 2014/35/EC

® EMC Directive 2014/30/EC

® Restriction of the use of certain hazardous substances (RoHS)
Directive 2011/65/EU

CE compliance of this product is valid if powered with the correct
CE-marked AC adapter provide by Avision.

This product satisfies the Class B limits of EN55022, EN55024,
safety requirements of EN 60950 and ROHS requirements of
EN50581.

*This machine is certified as Class 1 LED product.
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Disposal of Waste Equipment by Users in Private Union
I

This symbol on the product or on its packaging indicates that the
product can not be disposed of with your other household waste.
Instead it should be sent to appropriate facilities for recovery
and recycling in an effort to protect human health and the
environment. Fore more information about where you can drop
off your waste equipment for recycling, please contact your local
city office, your household waste disposal service or the shop
where you purchased the product.

As an ENERGY STAR® Partner, Avision Inc. has
determined that this product meets the ENERGY
STAR guidelines for energy efficiency.

i)

System Requirements

CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 2 GB
64 bit: 4 GB

Optical Drive: DVD-ROM Drive
USB Port: USB port 2.0 (compatible with USB 3.0)

Compatible Microsoft Windows 10 (32 bits/64 bits),
Operating Windows 8 (32 bits/64 bits), Windows 7,
System: Windows Vista, Windows XP(SP3)
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Product Safety Guide

Please clearly read all these instructions, and follow all instructions
and warnings before installing and using the device.

The following indications are used in this document to obviate any
chance of accident or damage to you and/or the device.

/N WARNING Indicates potentially hazardous situations, which

if instructions are not followed, could result in
death or serious injury.

/N CAUTION Indicates a potentially hazardous situation

which, if instructions are not followed, may
result in minor or moderate injury or damage to

property.

/N WARNING

Use only the AC power adapter that came with your device.
Using any other AC power adapter could cause fire, electrical
shock, or injury.

Use only the AC power cord and USB cable that came with your
device and avoid abrasions, cuts, fraying, crimping, and kinking.
Using any other AC power cord and USB cable could cause fire,
electrical shock, or injury.

Do not place objects on top of the AC power cord, and do not
allow the AC power adapter or the AC power cord to be stepped
on or run over.

Place the device and its AC power adapter near an electrical
outlet where the AC power adapter can easily be unplugged.

If you use an extension cord with the device, make sure that
the total ampere rating of the devices plugged into the
extension cord does not exceed the cord's ampere rating.

Place the device close enough to the computer so that the
interface cable can easily reach between the device and the
computer.

Vi
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B Do not place or store the device or its AC power adapter:
e Qutdoors
e Near excessive dirt or dust, water, or heat sources
e In locations subject to shocks, vibrations, high
temperature or humidity, direct sunlight, strong light
sources, or rapid changes in temperature or humidity

| Do not use the device with wet hands.

B Never disassemble, modify, or attempt to repair the AC power
adapter, device, or device option by yourself, except as
specifically explained in the device's documentation. This could
cause fire, electrical shock, or injury.

B Do not insert objects into any opening, as they may touch
dangerous voltage points or short-out components. Beware of
electrical shock hazards.

B Unplug the device and the AC power adapter, and refer
servicing to qualified service personnel under the following
conditions:

° The AC power adapter or plug is damaged.

° Liquid has entered the device or the AC power adapter.

° Object has entered the device or the AC power adapter.

° The device or the AC power adapter has been dropped,
or the case has been damaged.

° The device or the AC power adapter does not operate
normally (i.e. appearance of smoke, strange smell, odd
noise, etc.), or exhibits a distinct change in performance

B Unplug the device and the AC power adapter before cleaning.

vii
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/N\ CAUTION:
B Do not locate the device on rackety or aslope tables. Do not

locate the device on unstable surface. The device may fall
down and this may result in injury.

B Do not place heavy objects on the unit. It may cause
unbalance and the device may fall down. This may result in
injury.

B Store the AC Power cord/USB cable bundled out of the reach of
children to avoid the risk of injury.

B Keep plastic bags bundled out of the reach of children or throw
them away to avoid the danger of suffocation.

B |f you are not going to use the device for a long period, unplug
the AC power adapter from the electrical outlet.

viii
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1. Introduction

Congratulations on your purchase of the color sheet-fed
image scanner. With this scanner, you can scan documents
from the auto document feeder increase your productivity.

Before you install and operate the new scanner, please take a
few minutes to read through this manual. It provides proper
instructions for you to unpack, install, operate and maintain
the scanner.

1.1 Package Items

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.

1-1
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Scanner Software CD USB Cable

Quick Guide Power Adapter/Power Cord

NoOTE:
' 1. Only use the AC adapter DA-48M24 by APD included
¢ in the machine. Using other AC adapters may
damage the machine and void the warranty.

2. Please unpack the packing carefully, and check the
contents against the checklist. If any items are
missing or damaged, please contact your dealer
immediately.

3. To access more service supports, visit
www.avision.com to register your Avision’s product.

1-2
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1.2 Front View
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I TEM NAME DESCRIPTION
1 Extension Can be pulled out and adjusted to
the size of the document being
scanned.
2 ADF Paper Load the document onto this part
Tray when scanning document.
3 Paper Adjusts to the width of the
Guides documents to prevent skewing of
the scanned pages.
4 LCD Shows a number indicating a scan-
Screen to destination via the Up/Down
buttons.
5 Cancel Press to cancel a scanning job

during operation.

1-3
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10

11

Scan

Power

Output Tray

Position
Adjuster

Paper
Stopper

Paperweight

Press to start a scan.

Press to turn on the power.

Open to collect the document
after scanned.

Slide the adjuster inward to
make the Output Tray in a flat
position.

Adjust to the length of the
documents to prevent them
from falling apart.

Used to hold down a stack of
output paper.

1-4
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1.3 Rear View

| TEM

NAME

Kensington
Security Slot

USB Port

Power Jack

®

DESCRIPTION

Attach to a lock to secure the
scanner.

Connect to your computer.

Connect the AC adapter to the
scanner.

1-5
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2.

2.1

Scanner | nstallation

Precautions

Keep the scanner out of direct sunlight. Direct exposure
to the sun or excessive heat may cause damage to the
unit.

Do not install the scanner in a humid or dusty place.
Be sure to use the proper AC power source.

Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

Retain the scanner box and packing materials for
shipping purposes.

2-1
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2.2 |Installing the Scanner Driver and Connecting the
Cables

NOTE:
' 1. To ensure your computer can identify the USB
= scanner, please install scanner driver first before
connecting the scanner to your computer.

2. The scanner driver contains TWAIN, ISIS and WIA
driver. After the installation of scanner driver is
completed, this scanner allows you to scan via a
TWAIN, ISIS, or a WIA interface. Start your TWAIN-
compliant image editing software application to
select a TWAIN or WIA user interface or your ISIS
software to select an ISIS user interface. You may
also launch Microsoft’s Scanner and Camera Wizard
to scan via a WIA user interface.

2.2.1 Connecting to the Power

Before connecting, make sure the power switch is off.

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

2-2


https://manualsfile.com

User’s Manual

2.2.2 Turning on the Power

Press the Power Switch button on the front panel, the Power
LED will flash. When it is finished and ready to scan, the LED
indicator will stop flashing and become steadily on. To turn
off the scanner, press the Power Switch button for about 3
seconds, the Power LED will be off.

2.2.3 Installing the Scanner Driver

Place the supplied CD-ROM onto your CD-ROM drive.

2. The software installation graphic appears. [f not, run
“setup.exe”.

AViSiOI‘I Js www.avision.com

A vision of your off

Install Scanner Driver

Install Button Manager

Install A¥Scan X

View Manuals

2-3
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Contents on the installation graphic:

L]

I nstall Scanner Driver: To communicate with your
scanner, you need to install the scanner driver.

I nstall Button Manager V2: To use the buttons on
the scanner, you need to install Button Manager V2.
To ensure Button Manager V2 works properly, please
FIRST install scanner driver before installing Button
Manager V2.

I nstall AVScan X: To scan and organize your multi-
page document(s), you can install the software
application to manage them easily and effectively.

View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner and
Button Manager V2 respectively.

3. Click Install Scanner Driver to install the scanner driver
and then click I nstall Button Manager V2 to install the
Button Manager V2 unto your computer.

2-4
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2.2.4 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port at
the rear side of your computer.

2. The computer should detect a new USB device and prompt a
“New Hardware Found” message.

3. By following the on-screen instructions, click the Next
button to continue. When the certification screen appears,
click Continue Anyway to complete the installation.

4. When the Finish dialog is prompted, click the Finish button.

2-5
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3. Completing Your First
Scan

3.1 Loading Your Paper

3.1.1 Notice on Using the ADF

Before using the ADF, please make sure that your paper meets
the following specifications:

o Document(s) can range in size from 50 x 50 mm (2 x 2
in.) to 216 x 356 mm (8.5 x 14 in.).

. Document(s) can range in weight from 27~413 g/m? (7~
110 Ib.)

. ID cards up to 1.25 mm (0.05 in.) thick

) Document(s) should be square or rectangular and in good

condition (not fragile or torn).

. Document(s) should be free of curl, wrinkle, wet ink, or
punch holes.

) Document(s) should be free of staples, paper clips, paper
sticky notes.

3-1
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3.1.2 Loading Your Document in the ADF Paper Tray

Fanning Your Document

' NOTE:

To avoid occasional multi-feeds or paper jams, please fan

your documents and align the top edges before feeding
them into the scanner.

1. Hold both ends of the documents and fan them a few

times.

Rotate the documents by 90 degrees and fan them in the
same manner.

Align the edges of the documents in a step-like pattern
(see picture below).

Step-like

Scanning
Direction

3-2
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Document Feeding

1. Unfold the document feeder and its extension.

2. Unfold the output tray and raise the paper stopper.

W

ueog jsii4 JnoA Bupsjdwon
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3. Raise the paper guide to hold your multi-page document.

4. Load a stack of document face down with the top of the
pages pointing into the feeder.

5. Verify that the paper guides are aligned with the edges
of the stack.

3-4
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Note: The [Paper Width] switch:
If your document width is 216 mm (8.5 in.):

If your document width is 216 mm (8.5 in.), slide the
[Paper Width] switch DOWN to fix your paper guide to
conveniently load the letter-size document.

If your document width is larger than 216 mm (8.5 in.):

If your document width is larger than 216 mm (8.5 in.)
such as invoices with punch holes, slide the [Paper
Width] switch UP and move the paper guide to the right
end to load your documents.

w

Slide DOWN the [Paper
Width] switch to set your
paper width to 216 mm
(8.5 1in.)

ueds Jsii4 JnoA Bunsidwo)

Slide UP the [Paper
Width] switch to set
your paper width larger
than 216 mm (8.5 in.)

3-5
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3.1.3 Scanning Thin Paper

To scan a stack of thin paper, it is recommended to raise the
paper weight and then make the output tray in a flat position to
keep the paper from rolling or possible paper jams due to the
paper stack in the output tray.

For normal document scanning, press down the paperweight
and keep the output tray in an angled position to prevent paper
from falling apart.

To scan thin paper,

1. Lift up the paperweight as shown.

2. Slide the position adjuster of the output tray to make the
output tray in a flat position.

3-6
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3. Load a stack of thin paper into the paper tray. Align the
paper guides and make sure the edges of paper slightly
touch the paper guides on both side as illustrated.

w

o)
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3.1.4 Scanning a Stack of Document with Various sizes
and Weights

When scanning a batch of documents with different sizes and
weights, be sure to follow these guidelines to avoid a skewed
image or a paper jam:

1. Align the documents TOP EDGE first in the sequence of
paper size from large to small.

i

2. If two pages are of the same size yet with different weight,
arrange these pages in the sequence of paper weight from
heavyweight to lightweight.

n27g) |

(60g)
(28q) |
(650

(38g)

3-8
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3. Align the edges of the documents by tapping the bottom of
the stack against the table top.

Ad

S

4. Center these pages in the document feeder and make sure
that the edges of page of the largest size slightly touch the
Paper Guide.

W

ueog jsii4 JnoA Bunsidwon
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3.2 Verifying Your Scanner I nstallation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.
1. Select Start>Programs> Avision xxx Scanner> Avision

Capture Tool. The Select Scanner Model dialog box will be
displayed.

Select Scanner Hodel

E3

Ciriver Tupe:
[Tl

Scanner Model:
|Avision jeem ~

~| Cancel

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.
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Fit Actual

E Avision Capture Tool (TWAIN) - XXxx
File View About

@Set\m o S |'—'ﬂ File Format. | BMP vl‘c\MYScan\\mage EE D

' Save  File Format  pijo patp

Setup Scan

Choose your desired file format from the File Format drop
down list box. (Default is JPEG, other choice includes TIFF,
MTIFF, PDF, MPDF, GIF, and BMP.) The supported file
formats vary depending on your scanner model.

Type your desired folder name and file name in the File
Path box. (Default is C:\Documents and Settings\User
Name\My Documents\My Scan\Image.)

NOTE:

If you do not wish to save the scanned image, deselect
the Save button since default is Save Enable. In this case,
the thumbnail view will be disabled. And therefore, after
viewing all the scanned images, only the last one will
remain on the screen.

‘s Se
Click the Setup button ( ﬁ tLllJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.

3-11
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10.

ot Stanner Properties II!Q!J
image. |Paper | Semng | Ifamabon
Frat Aut Coler Detection Tinanzation | Enyrarics Thamabaikd
'ﬂ"lM Senatnty FL
Frsxd Gty
¥ |Feont BAW
Image ——
H Flanc At Colot Desechon | | Regchaion. (ol [200.
Selection p— -
ven. | Biacic on White
Box iy

[Fiear AW
Samea satings for both sides

e Senaren. | pute, Qlecument Fondee

[~ Prolies L

Defeks O || Cecel

From the Image Selection Box, choose your desired image
type for your scanned image (Default is Front B&W). If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

ﬁ' Sran .
( ) or choose Scan from the File menu.
The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.

3-12
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Display View

Thumbnail View

. You can view the scanned image in Fit Page (‘E‘) or

ueog jsii4 JnoA Bunsjdwon

Actual Size (100%) button ( D ) from the Viewing toolbars
at the right side.

. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.
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3

-t

W

(3]

N o

.3 A Glance of the Scanner Properties Dialog Box

8 ——Defauis ok | [ Cancel

= Scanner Properties B3|

iwoge | Paper | Geting | bfematon]

2 7] [Front Ao Color Detedtion ] Einarization: Dynamic Threshold -
] [Front Color Sensitivity: 20 4 [
0 [FontGray

] |[Front BaW ]

Rl e T O s — |
"] |Rear Color

| [RearGray )
7 [RearBaW

| Same settings for both sides 7

o0 bhW

vet: [ Black on White ~

Scan Source: Ao Document Feeder z)

. Tab Options

. Image
Selection Box

. Brightness
. Contrast

. Resolution

. Invert
. Scan Source

Choice: Image, Compression, Color Dropout,
Paper, Multi-Feed Detection, Preview, Options,
Settings, Information.

Choose your image type and the side of
document you wish to scan. Options vary
based on type of scanner.

Adjust the brightness level from —100 to + 100.
Adjust the contrast level from —100 to +100.

Determine the quality of the scanned image.
The industry standard is 200 dpi.

Reverse the color of your scanned image.

Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

3-14
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4. USING THE SCANNER
PROPERTIES DIALOG BOX

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

NOTE:
' In this chapter, all options are available based on a
®  duplex (double-side) scanner. If you have purchased a
simplex (single-side) scanner, all options are available for
single sided only.

s Scanner Properties
Image | Paper | Setting | Information

[ [Front Auto Color Detection | | Binarization: Dynamic Threshold -

B — R @

o o
—

|[Front B ;

B Feskion Fr— -
"
m
m

[] Same settings for both sides

Invert: lBIack an White V]

Scan Source: | Auto Document Feeder |

Profies... | |Custom -

The Scanner Properties dialog box

4-1


https://manualsfile.com

User’s Manual

4.1 Buttons on the Scanner Properties Dialog Box

-2+ Scanner Properties [E3e]

Image | Paper ISeﬂ.mg I \rdormatlonl

[T |Front Auto Color Detection Binarization [Dfnamlc Threshold v]

Sensitivity: M4 ™ ¢

[7] [Rear Auto Color Detection Resolution {dpi): [21)0 e ] E]
L]

Invert [Black an White V]

[] Same settings for both sides

Scan Source: [Mu Document Feeder ']

Profies... | [Custom -

The buttons on the Scanner Properties dialog box

BUTTONS DESCRIPTION

Defaults Click the Defaults button, the factory default
settings will be shown on each tab.

Cancel Click the Cancel button to leave the Scanner
Properties dialog box.

4-2
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The following table shows the default settings :

TAB NAME DEFAULT SETTINGS
Image Image : Front B&W
Binarization : Dynamic Threshold
Resolution : 200 dpi
Invert : Blank on White
Scan Source : Auto Document Feeder
Threshold : None
Brightness : None
Contrast : None
Compression None
Color Dropout None
Paper Cropping : Automatic
Deskew : Yes
Orientation : Portrait
OverScan : 0.00

Note: The availability of this option
varies due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None

Blank Page Removal : None
Edge Fill : White > 0 mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15
minutes after last scan action

Show Scanning Progress : Yes

Show Warning Message : Yes

Save Settings after Closing : Yes
I mprinter Digital Imprinter

c
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4.2 Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default
with three basic tabs - Image, Paper, and Information. To
show more tabs, click the [Scanner Properties] icon to access
more scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab names.
The available tabs include Compression, Color Drop out,
Preview, Rotation, Separation, Multi-Feed, Options,
Settings, and Imprinter. (Note: the options vary based on
scanner model.)

Choose the tab you want to display. The selected tab will
be shown with a check mark and then displayed in the
[Scanner Properties] dialog box.

To access the settings, click the selected tab on the top of
the [Scanner Properties] dialog box. The page of the
selected tab will be displayed.

To hide a tab window,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tabs] to show available tab
names.

Choose the tab you want to hide. Then, the selected tab
will be hided in the [Scanner Properties] dialog box.

Note: The [Image], [Paper], and [I nformation] tab can
not be hided since they preprogrammed to be displayed by
default.

4-4
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Tabs 3 Compression
T Color Dropout
o [ AltsFd Multi-Feed Detection
T |Fror Color Frenca
Rotation

S =r—
Separation
|Front E&W Enhancement

¥ | Setting

L=

O [RearCoor ]
O BeaGmy ]
I [RerBew ]

[ Same settings for both sides

Invert:

2 ¢ e i
i ;
- b

Black on White ']

Scan Source: [Mo Document Fesder

Profiles. ..

] custom

Defaults
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4.3 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

‘4 Scanner Properties

[ [Front Auto Color Detection Binarization {Dynamlc Threshold V]
[Z] [Front Calor Sensivity: 204 (™= '
o

= 1 : 4 b

7] |[Front B&W o

[T] [Rear Auto Color Detection Resolution {dpi): [21}0 ']C]

[C] |Rear Color
[0 |Rear Gray
[C] |Rear B&W

[] Same settings for both sides

Invert [E‘vlad( on White ']

Scan Source: lMu Document Feeder 'I

l Profiles... HCLIstnm vI

Defauks oK

The Image tab dialog box
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4.3.1 The Image Selection Box

Frort 4uto Color Detection

T The Image Selection box includes the
image type and document side option. If
you wish to scan both the front side and
the rear side of your color document, you
can check both Front Color and Rear Color
e at the same time. Note the options vary
=T based on type of scanner.

B0

Fiont B&w

Reat Auto Color Detection

4

oo
=] =] n o
£
g

00 F O

Example 1 : Scanning a two-sided color document, both
sides in color

0 Fot Ao o
o T —
T —
ST —

O emAsstio bassion )
o —
T —
T —

Side/ Image Front
Selection

Rear

xog Bojeiq seipedold Jsuueog sy Buisn
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Example 2 : Scanning a two-sided color document, one
in B&W, the other in color

1ont Auto Color Detection
1ot Colot

ont Gray

Oo0oEO

Rear Auto Color Detection
st Colar

eal Gray

)| (@ T @ @] =@
3
m
2

8OO0

Rear BiWw

Side/ Image
Selection

Phrbetgoace— W e Mgl At

FI‘OI‘It Rear

I MAGE TYPE
Color

Gray

B&W

DESCRIPTION

Choose Color if you wish to scan a color
image for your original in color.

Choose Gray image if your original contains
actual shades of gray.

Choose B&W if your original contains only
text, pencil or ink sketch.
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Front/ Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear
page of your color document in color image mode. If your
document is in colors, the scanner will automatically scan the
document into a color image. If your document is non-color,
you can choose the output to be either B&W or Gray from the
Non-Color Selection option. This option is useful when you
have a mixture of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you can
not specify the image mode of your rear page and vice versas.

S

Modes of Auto Color Detection:

If [Front/ Rear Auto Color Detection] is selected, its modes
will be displayed. Choice includes Normal, Ignore Paper
Color. For paper with background color such as invoices,
choosing [l gnore Paper Color] will automatically remove the
background color and enhance the detection accuracy.

- By g ] Bun o ro0r
EVOICE Sl iy PVOICE S §ta

2
xog Bojeiq seipedold Jauueoag sy Buisn

uw ww

Normal Ignore single
background color
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Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small
amount of light or pale colors and you do not wish them to be
recognized as color image to save the file size, you can
increase the sensitivity value by moving the bar to the right to
let these images to be detected as B&W. The value ranges from
1to 100. The default is 37.

Standard 1EEE 802.11 b/g/n standards compliant

Wireless LAN 1T1R Mode

Frequency Range | 2.400 ~ 2,4835GHz ( subject to local regulations) |

802.11n: 20MHz/40MHz

UsA,  Caneda  (FCC)i11  channels
Number of (2.412GHz~2.462GHz)
Selectable s02.1
Channels Lbyg: | EUToPe (CEY: 13 channels (2.412GHzn2.472GH2)
g:
Japan (TELEC): 14 channels

(2.412GHz~2.4835GHz)

802.11n: up to 150Mbps.
Data Rate 802.11b: 1, 2, 5,5, 11Mbps.
802.119: 6,9, 12, 18, 24, 36, 48, 54Mbps

11n HT40 MCS7 : +13 dBm

TN

Transmit
11g OFDM: +15 dBm

Power(EIRP)
11b CCK: +18 dBm

Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802.111

Original

Standard 1EEE 802.1 b/g/n standards compliant Standard 1EEE 802.11 b/g/n standards compliant

Wireless LAN 1TIR Mode — Wireless LAN 1TIR Mode

Frequency Range | 2.400 ~ 2.4835GHz ( subject to local regulations) | Frequency Range | 2.400 ~ 2.4835GHz ( subfect to local regulations)

802.11n: 20MHz/40MHz ) 802.11n: 20MHz/40MHz

UsA,  Canada  (FCORI1  chamnels USA, Canada  (FCC)11  chamnels

Number of (2.4126Hz~2.462GH2) Number of (2.412GHz~2.462GHz)

Selectable 8021 Selectable 021

Channels Lorge | EUFOPe (CEY: 13 channels (2.4126Hz-2.4726H2) Channels Lojg: | EUT0Pe (CE) 13 chamnels (2.4126Hz~2.4726H2)
Japan (TELEC): 14 channels Japan (TELEC): 14 channels
(2.4126Hz~2.4835GH2) (2.4126Hz~2.4835GHz)

802.11n: up to 150Mbps 802.11n: up to 150Mbps )
Data Rate 802.11b:1, 2, 5,5, 11Mbps Data Rate 802.11b: 1, 2, 5,5, 11Mbps
802.11g: 6, 9, 12, 18, 24, 36, 48, S4Mbps 802.11g: 6,9, 12, 18, 24, 36, 48, 54Mbps
N ~ < e m—

110 HT40 MCS7 : +13 dBm LINHTAO MCS7 : +13dBm

Transmit Transmit
119 OFDM: +15 dBm
Power(EIRP) Power(EIRP) 119 OFDM: +15 dBm
11b CCK: +18 dBm 11b CCK: +18 dBm
Security WEP 64/128, TKIP, WPA, WPA2 mixed,802. 1x and 802.111 Security WEP 64/128, TKIP, WPA, WPA2 mixed,802.1x and 802,111

Sensitivity: 1 Sensitivity: 100
(The image is recognized (The image is recognized
as a color one) as a black and white one)
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Same settings on both sides:

Click to apply same scan settings for both sides of your
documents. After checking this option, any settings you have
changed will automatically applied to both the front side and
the rear side. For example, if you choose your ideal resolution
to be 300 dpi, this will be applied both to the front side and
rear side of your document.

4-11
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4.3.2 Other Image Options

Binarization

This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Options: Dynamic Threshold,
Dynamic Threshold (AD), Fixed
Processing, Halftone 1~ 5, Error
Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Dynamic Threshold (AD): Selecting
Dynamic Threshold (AD) to perform
the enhanced mode of the Dynamic
Threshold feature. However, using this
mode may slow down your scanning
speed.

Sensitivity of Dynamic Threshold
Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.

4-12
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Fixed Processing: Used for black-and-
white and other high contrast documents. A
single level is set to determine the black-
and-white transition. The threshold is
programmable over the entire density
range. Fixed Processing sets Contrast to
0. If Fixed Processing is selected,
Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

N

Error Diffusion: Error Diffusion is a type
of Halftone. Error Diffusion gives good
image texture and makes text in images
more readable than Halftone.

xog bojeiq seiadold Jauueds ayy buisn
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from 0 to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

1

200 dpi, 200 dpi,
Threshold:50, Threshold:100,
Brightness: 0 Brightness: 0

4
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Gray

Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

) Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

) Photo: Choose Photo if your original contains photo to
reproduce your photo in vivid grayscale image. When
using Photo, no Threshold and Contrast can be adjusted.

o Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from 0 to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Normal Photo Docum_eni
(Threshold: 230)

4

iz

i

Normal

Document
(Threshold: 230)

xog Bojeiq seiadold Jeuueds ay buisn
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to + 100.

Brightness: -50 Brightness: 0 Brightness: +50
(Normal)

Contrast: -50 Contrast: 0
(Normal)
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Resolution A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150, 200,
300, 400 and 600. Or you may choose your
desired value by clicking the box in the right
side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list. Note: The resolution is up to
300 dpi if an imprinter or a MICR reader is
installed or connected to the scanner.

xog Bojeiq seipedold Jsuueag sy Buisn
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Resolution: 75 dpi
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Invert Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“E am not worthy to have you gnter my

: that is God, I beg all my brothers - those w
e who work manually, clerics and |ay brothers
ards belng humble in all things; not to glorify
r to become interlorly proud because of good w
sometimes says or does in them or through tl
ard:  “Do not rejoice--- in the fact that the de
0 10:20} Let us be firmly convinced of the fact

Black on White

“I am not worthy to have you entar m

that is God, I beg all my brothers - those v
E who work manually, clerics and lay brothe

rds being humble in all things; not to glorify
te becorne Interlerly proud because of gand
sometimes says or does in them or through 4
rd; “Do not rejoice-- in the fact that the dd
10:20) Let us be firmly convinced of the fa

W hite on Black

Scan Choice:
Source + Auto Document Feeder: Used to scan
multiple pages.

+ Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

+ Flatbed (book): Used to scan several
inside pages from book.

« Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
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document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

+ Merge Two Sides into One I mage:
If you have a sheet-fed duplex scanner with
front input tray, you can scan an A3 size
document with an innovative method. Thus,
fold your A3 size document into A4, and then
load the paper in the front tray. Choose
Merge Two Sides from the Scan Source
option and then the scanner is able to scan
both sides of your document and merge two
A4 images into one A3 image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note: This feature must be used with a
carrier sheet. Regarding how to load a
document with a Carrier Sheet, refer to
Section 4.6.2, Other Paper Selection.

Note the options vary based on type of
scannetr.

NOTE:

If you have purchased a duplex sheet-fed
scanner, choose [Merge Two Sides] on the
[Scan Source], then the scanner is able to
scan both sides of your document and
merge them into a single image.
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If “Merge Two Sides into One Image” is
selected, its choice will be available including
“Merge Horizontally”, “Merge Vertically”, “Merge
Vertically (Back Side Flip)”. If the reverse side
of your document is upside down, choose
“Merge Vertically (Back Side Flip)” and the back
side will be automatically rotated 180 degrees

and merged.

Front
Side :
...................... Front { Rear
Side | Side
Rear :
Side
Merge Vertically Merge Horizontally

Note the options vary based on type of
scanner.
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Color The purpose of Color Matching is getting the

Matching accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

Choice: None, Document, Photo

e None: Choose “None” to disable this
option.

e Document: Choose “Document” if your
original contains pure text or a mixture of
text and graphic since it is an optimal
setting for regular business document.

e Photo: Choose “Photo” if your original
contains photo to reproduce your photo
in vivid color image.

4

xog Bojeiq seipedold Jauueoag sy Buisn

0

After Color Matching
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4.3.3 Scanning color images
The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert

4.3.4 Scanning grayscale images
The following options are available for scanning gray images.
. Brightness

. Contrast
. Resolution
. Invert

4.3.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)

. Threshold
. Brightness
. Resolution
. Invert
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4.3.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1. Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

2. Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

[ e Feapts ==

4

ey e ) S Lo T

) Edit Yous Prufie o )
= | -

s s = ot Diughes, BUEW, 200 g L1 —"1 L

==

5 :

3. Click “Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Please enter the name of the profile:

xog Bojeiq seipedoid Jsuueag sy Buisn

[ Save J| Cancel |

4. The new profile will be saved and shown in the “Profiles”
dropdown list box.

4-25


https://manualsfile.com

User’s Manual

To load a profile,

1.

2.

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Your Profile \EI

Profie < [ A | [ oeee |

| [ Fename.. | | Feset J

Duplex, Gray, 200 dpi
Simplex. B&EW, 200 dpi
Simplex, Calar, 200 dpi
Simplez, Gray, 200 dpi

Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile EI

Profile: [ Fiatbed -] [ Add.. ] [ Delete |

[ Rename | [ Reset ]

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you want
to delete this profile?” is prompted.

Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile = |[-E- )
Profile Betsy ~ [ Add ] | Delete ]
Duplext, Ba&H, 200 dpi [ Rename ] [ Reset ]

Duple’, Color, 900 dpi
Duplex;, Gray, 200 dpi
Flat

thed.
Simplex, B&&W, 200 dpi
Simplex, Color, 200 dpi
Stmpless Gray, 200dp | Exit ]

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.
Rename a Profile @

Pleaze enter the new name of the profile:

Original M ame: Betsy

Mew Mame:

Save ] Cancel |

4. Choose “Save” to save the new profile or “Cancel” to quit.

NOTE:
' 1. The preset default profiles include Flatbed, Simplex-
¢ B&W, 200 dpi, Simplex-Gray, 200 dpi, Simplex-
Color, 200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray,
200 dpi, Duplex-Color, 200 dpi. If you have a
simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.

xog Bojeiq saiuedold 1auueag ay buisn

2. If any setting for a current profile has been changed,
a [*] sign will be marked before the name of current
profile, for example, [* Duplex, Color, 200 dpi]. If
desire, click the [OK] or [Scan] button and a dialog
box will be prompted to let you save the new profile.
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4.4 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4

4-28


https://manualsfile.com

User’s Manual

:Q Scanner Properties @

| image | Compression | Paper | Setting | Information

E

I ek o Dot |
S —
o —
S T a—

4

The Compression tab dialog box

xog Bojeiq semadoid 1auueag ay; buisn
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4.5 The Color Dropout Tab

4.5.1 Color Dropout Selection

The [Color Dropout] tab allows you to select either green,
red, blue, or a color of your choice to remove the details of the
selected color from a scanned image. This feature is used to
sharpen your text when using OCR (Optical Character
Recognition) software. Note this feature applies only to the
gray or black and white image.

Choice: None, Auto, Remove Red, Remove Green,
Remove Blue, Custom

None: Does not remove any color.

Auto: Automatically outputs the image with the details of
the primary color removed.

Remove Red/ Remove Green/ Remove Blue: Outputs
the image with the details of the specified color removed.
Custom: Specify the color you wish to remove by entering
its RGB (Red, Green, and Blue) value respectively.

Advanced Options:

Quality Mode: Range: 0~20. Default: 10

When [Quality Mode] is selected, you can determine the
color to be dropped out using the [Filter Threshold] slider. A
lower value will drop more of the selected color out, while a
higher value will leave more of the selected color in.
Normal Mode: Use an optimized setting to determine the
color.
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At 3o days after —. sicar

(FIRST OF THE SAME TER@R AND\DATE |

’\ I -hu Infernatio
F Yy | THE SUM OF

Original

at Jo daycafter  sicar

(FIRST OF THE SAME TENOR AND DATE
I Hsinchu Internatia
I THE SUM OF

Remove Red (normal
mode)

a1 3o _dayg after SIGHT |
(FIRST OF THE SAME TEN@R Al DATE 1

sinchu, rnatio
THE SUM OF

Auto/ Remove Green
(normal mode)

s1_30 dayg after SIGHT
(FIRST OF THE SAME TER@R AND\DATE

inchu rnatio
THE SUM OF

Remove Green (quality
mode: Threshold: 18)

4

Preview the color dropout result:

To preview the color dropout result, please follow these steps:

1. Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab
names.

2. Choose [Preview] to show the Preview tab.

Click the [Preview] tab to show the Preview page.

xog Bojeiq semadoid 1auueag ay; buisn

4. Load your document to the scanner and click the
[Preview] button to get a preview image.

5. On the [Image] tab, click [Gray] or [Black and White]
image mode and then choose [Custom] on the [Color
Dropout] tab. A [Preview window] button will be
displayed.

6. Click the [Preview window] button to prompt the
[Preview] window with the previewed image.
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Move your cursor over the preview image. Your mouse
cursor now becomes an Eyedropper.

Click to select a color which you wish to remove.

Click and hold your mouse button to view the result
after removing the specified color. If the result is
satisfactory, click [OK] to close the Preview window.

= ==

- [ FrovemRean ] o - [ Fevenfema | oK
R T2.010.0: 116 Cancl B8, 200, 162 =

The Preview Window The Color dropout result
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2+ Scanner Properties @

Image |Compression Color Dropout | Paper | Preview ISeﬂing I lnforrnaﬁon|

|Frort Auto Color Detection Color Dropout: [None V]

Front Color ) Advanced Processing

&
Front B&W

SN

Cox [ o

The Color Dropout dialog box

xog Bojeiq semadoid 1auueag ay; buisn
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To select a color on the Color palette,

1. Click the Color {:‘I""w_wm — =]
Dropout tab from [ e

the Scanner ; " E———
Properties dialog =T :
box.
Fowr BV
| D | on Concel,
2. Choose Gray or i =|

| imape | Comormason | Cotor Drvns | Pager | Priview | Setting | infomation

B&W from the
Image Selection
box and click
“Custom” from the
Color Dropout

drop-down menu. o S e
The Color palette et 2 .
| Frmsemn Windew
appears.
| Orsds | on Concel,
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Move your cursor TR — _ =
| Image | Comprasaon ] Cokr Cspect [ Fuger | Pwven | Seing | fovanen
over the palette. The

(= -
cursor becomes a .
. (et Gy
cross sign. o B
::. |
e ]

|
. Treview Window

4

| Didsitn [ o | Cancel

Click to choose a color. The RGB values are changed
simultaneously.

xog bojeiq senadold Jauueosg ayj buisn
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4.6 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

2 Scanner Properties

| Image I Compression I Color Dropot | Paper | Preview | Setting | Irﬂnrrnatlnn|

Cropping: lMcmabc 'J
[ Cantier Sheet Mode

None

@ Portrait Landscape
0.0 8.50(=
0.00 14.00}=
Adjustment: Left: 0002 Top 0.00 =
Right: 0.00 = Bottom: 000
Background Setting: [Whﬂe Background vl
Urit: [\nches 'I
Feeding
Transport Timeout: 4 I_ b [0 Seconds

Cx [ o

The Paper tab dialog box
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4.6.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Automatic (36”),
Fixed to Transport, EOP (End of Page) Detection,
Automatic Multiple, Relative to Documents.

OPTIONS DESCRIPTION

Automatic Automatic adjusts the cropping window
according to different document sizes and
automatically straighten a skewed
document. Use this option for batches of
mixed-sized documents.

S

Automatic Automatically adjusts the cropping window

(367) according to different document sizes
smaller than 36” and automatically
straighten a skewed image. Use this option
for batches of mixed-sized document.

Note: The availability of this feature
varies due to scanner model.

Fixed to This feature allows you to define the area

Transport or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.
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EOP (End of  Thjs feature allows you to define the area

Page) or zone to be imaged. Use for batches of

Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
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change the values.

Automatic This option allows you to place various

Multiple sized documents such as photos, ID Cards,
or business cards on the flatbed (if
available) and lets you create multiple
individually cropped images in one scan.
Note: To correctly create multiple images,
please make sure there is at least 12mm
(0.5”) of space between each document.

Relative to This option allows you to crop different

Document areas on your documents and deliver these
images in B&W, Gray, or Color separately.
For example, there are applications which
require you to store the entire document in
B&W and a part of the document in color to
save storage space. This is useful for
documents where a photograph or
signature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.

. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.

The Adjustment option is available when Automatic is
selected
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Adjustment —adds a positive/negative margin value
Top/Bottom or toward left/right of the image.

Adjustment is used when the automatic document feeder
is used. Adjustment reduces the possibility of corner
clipping on skewed images. To set Adjustment values, use
the UP/Down buttons to select where you want to apply
Adjustment values: Top/Bottom or Left/Right, and then
select the amount of inches/mm/pixels applied. Select a
value within the range of 0.00 to 1.00 / -1.00.
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Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1.  On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, 1SO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’s maximum.)

o+ Stanaer Propatties ==
imagn | Paper | Frevew | Seang | infomaon
Frord At Color Dvtnction "R E T
Froat Coke
Froet Gy
! [Frort BAW
Ploar s Coler Diotocten

P Color

== T Ared

Fea BAW

rectangular
box

®
7
i
Logeelicalin i)

Dietauby L d o Cancel
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3.

Click the Preview tab to display the Preview window. A

black rectangular box appears to indicate the max. scan
size your have just selected.

The Image
Selection
Box

|| Scarmar Eraperties
e | Comowsacn | ol Tragout | g | P | St | fomupin

s Ak ok ateszon

-

A black
rectangular
box

Click the Preview button to view the entire image in low

resolution to correctly crop your relative scan area.

| o Samner Brepesten

[y

The Preview
Image

The Preview
Button

Select image type from the Image Selection box. The

selected image will appear in highlighted color. (For
example, Front Color)

Place your cursor on the Preview window and click your

left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected

area will appear in a red box as illustrated.
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Check the B&W image from the Image Selection box to

scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)
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4.6.2 Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). Note: The availability of this option varies due to
scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading
non-standard document onto the scanner. It allows you to scan
document that can not be scanned in the regular way. Also,
documents larger than A4 size, such as A3 and B4, can be
scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that
can be damaged quite easily such as photographs, or irregular
size documents that are difficult to load directly such as

clippings.

To scan document using a Carrier Sheet,

For documents larger than A4/ Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise,
the sheet may be skewed during scanning.

xog Bojeiq sanedold Jauueds ay) buisn
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1. Open the Carrier Sheet and place the document
inside.
Align the top of the document to the top of the Carrier
Sheet (the printed area).
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For documents larger than A4/ letter size, such as
A3

Align the top of the document to the top of the Carrier
Sheet (the printed section) and the folded portion to the
right edge of the Carrier Sheet so that the document fits
into the Carrier Sheet at the upper corner.

For non-standard document
Center your document in the Carrier Sheet.

Load the Carrier Sheet with the gray section (printed
section) facing downwards.

Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space
between the guides and the Carrier sheet. Space between
the guides and Carrier Sheet may cause the Carrier Sheet
to become unaligned during scanning, and skew the
scanned image.

Start the scan.
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NOTICE:
' e [Carrier Sheet] is available for the models that
¢ support the Carrier Sheet.
e Some functions are disabled when [Carrier Sheet] is
checked.
e This option may not work properly on some
applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choices are listed below:

None
US Letter- 8.5”x 11”

US Legal - 8.5” x 14”
1SO A4 - 21 x 29.7 cm
1SO A5 - 14.8 x 21 cm
1SO A6 - 10.5 x 14.8cm
ISO A7 -7.4x10/5 cm
1SOB5 -17.6 x 25 cm
1ISOB6 - 12.5 x 17.6 cm
1ISOB7 - 8.8 x12.5 cm
JISB5 - 18.2 x 25.7 cm
JISB6 - 12.8 x 18.2 cm
JISB7 - 9.1 x12.8 cm
Scanner Maximum
Long Page (<118”)

xog Bojeiq seipedoid Jsuueag sy Buisn
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Long Page (<118”):

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be
available. (Note: This option and the maximum allowable
document length vary due to type of scanner.)

When Long Page (<118”) is selected, be sure to specify your
document size in the Length and Width field.

Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent
the ejected paper from falling off the Output Tray.

3. To ensure the performance, in color mode, set the
resolution to be 300 dpi or lower; in Black and White
mode, set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or
your specified paper size, there may be insufficient
memory to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.
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Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable. Note: The availability of this option varies due to
scanner model.

Transport Timeout

Set the amount of time the scanner will wait and then start
auto scan after the first scan job is completed. If you have
many separate documents need to be scanned at the same
scan settings, this feature is especially useful. The default is 0.
The value ranges from 0 to 30 seconds.

NOTE:

' e Within the specified timeout period, if you load your
e document to the feeder, the scanner starts scanning
automatically.

e |f your scanner has a flatbed option and you place
your paper on the flatbed, after the timeout period,
you need to click the Scan button on the TWAIN user
interface to start scanning.

xog Bojeiq seiuedold Jauueog sy Buisn
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Background This option allows you to set your scan
Setting background. Choice: White Background,
Black Background.

Note: For a sheet-fed scanner with an auto
document feeder, this option is currently
available only in the “Auto crop” mode. For a
scanner with a flatbed platen, this option is
available either in the “Auto crop” or the
“Fixed to Transport” mode.

3 N
White Background

S
Black Background
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4.7 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

“5# Scanner Properties

‘ Image | Paﬁ‘ Muiti-Feed Detection | Preview | Setting I Information
Multi-Feed Detection
[~ Additional Length Detection: None =
[7] Uttrasoric: Detection

Stop Scan

&
o

Unit: Inches -

Defaulls oK
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of 0 indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.

Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note : The
availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

B [f this is selected, the scanner will stop the feeder and
prompt a multi-feed warning message. In addition,
the multi-feed paper will be ejected from the scanner
automatically.

Note: The availability of the [Auto Clear Multi-Feed
Paper] feature varies based on scanner type. If your
scanner does not support this feature, remove the
multi-feed paper manually.

B |f this is not selected, the scanner will continue
scanning the entire document though multi-feed is
detected. After the entire document has been scanned,
a multi-feed dialog box will be prompted to indicate
the page number which has been detected multi-feed
and need to be rescanned.
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e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

How to add the sound alarm :

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.

3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.8 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

s Scanner Praperties EXE

| Image | Compression | Color Dropout | Paper | Preview | Setting | Information |

S
] e —
[ [earColor ]
= — ;

Scan Area 7
[150 A4-210x 287 mm - 8

o b W N

The Display
Window

@) Portrait

HOffset 0.12
YOffset: 0.00 =

Width 827 -

Length 1169 =

Uit Inches ~|

[ Selected area applies to all modes

Defoults [ Pevies | [ ok ][ Concel |

The Preview Tab
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4.9 The Enhancement Tab

The Enhancement tab allows you to set following additional
image processing settings.

-4 Scanner Properties @

[ Image | Paper | Mutti-Feed Detection I Frevlewl Enhancement | Setting I Information |

Punch Hole Removal

Funch Hole Removal

Background Setting

None

5
2
@

Edge Fill
@ White [~ Edge Edend
7 Black 0 Milimeters
Despeckle Line Removal
Noise Number: 0 |= Piels
Moise Radius: 1 [&] Puels 100| Milimeters

The Option tab dialog box
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Punch
Hole
Removal

You can remove punch holes from the output
scanned image when scanning punched document.
Note the availability of this feature varies
depending on your scanner model.

Original Output image

Punch holes can not be removed when:

Resolution is set lower than 150dpi

The hole is near the edge of the document

The holes are not aligned along the edge of the
document

Punch Hole Removal is available only when
“Auto Crop” is enabled. If either “Fixed to
Transport”, “EOP (End of Page) Detection”,
“Automatic Multiple”, “Relative to Documents” is
selected from the Cropping option on the Paper
tab, the Punch Hole Removal option will be
disabled.
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Shadow Removal When T"Flatbed ; on the "Scan
Source | option is selected on the
"Image | tab, the "Shadow
Removal ; option will be enabled. Click

to remove the shadow on the book spine
when scanning a book.

1N

(RLI

1= | |=—_

Before Shadow After Shadow Removal
Removal

xog bojeiq seadold Jauueos ayj buisn

4-55


https://manualsfile.com

User’s Manual

Background Processing: The [Background Processing]

option allows you to smooth background color or remove it to

make image clearer. The option is especially useful for

documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed
(default)

- Smooth - produces images with a more uniform
background color. This option improves image quality.

-  Removal - identifies the background color and then
removes it.

Sensitivity: Choice: 0,1, 2, 3, 4. Default: 0
- The higher the value, the more background color will be
kept.

Mode: Auto, Moiré

If [Smooth] is selected in the [Background Processing]

option, then the choices for the [Mode] option includes Auto,

and Moiré.

- Auto - uses the factory preprogrammed mode to proceed
background smoothing.

- Moiré — Remove the moiré patterns that appear on the
background of the image when scanning printed material.

If [Removal] is selected in the [Background Processing]

option, then the [Mode] option will be replaced with [Fill

Color]. Choices: White, Auto.

- White - identifies the background color and substitutes it
with white.

- Auto - identifies the background color and substitutes it
with the color of the largest background zone.
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NOTE:
Background color in small zone will not be processed or
removed.
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Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from 0 to 5 mm. Default value is 0.

Original Edge Fill: 5mm (Black)
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Despeckle

Occasionally small dots or specks appear in the background of
a scanned image. Remove unwanted speckles provides a
cleaner image for OCR (Optical Character Recognition)
processing, and also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.

%plague on thee! Hast thou
never an eye in thy head? Canst
not hear? .
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

Before Despeckle
(noise number:0, noise radius: 1)

%plague on thee! Hast thou
never an eye in thy head? Canst
not hear?!
—The First Part of King Henry the Fourth:
2.1.26-27

A carrier to Gadshill, the host of a tavern.

After Despeckle
(noise number:22, noise radius:10)

xog bojeiq seiadold Jauueds ayj buisn

NoOTE:
' e The function is currently available for Black and White
¢ image only.

e To scan at rated speed, it is recommended to set the
noise radius up to 10 pixels.
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Line Removal: When Black and White image mode is
selected on the [Image] tab, the [Line Removal] option will
be enabled. Line Removal erases lines on the image and then
reconstructs characters so the OCR (Optical Character
Recognition) accuracy can be improved.

Choices: None, Form, Horizontal, Vertical
None — the default mode which does not remove any line.
Form — remove any form in the document.

Horizontal — select [Horizontal] and then enter the length of
horizontal line to remove only the horizontal line exceeding
your specified length.

Vertical — select [Vertical] and then enter the length of
vertical line to remove only the vertical line exceeding your
specified length.
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4.10 The Rotation Tab

The Rotation tab allows you to set the following image rotating
options:

:sf; Scanner Properties

| Image I Paper | Mutti-Feed Detection I F'reriewl Rotation | Enhancement | Setting | \nfcrrnahonl

Rotation

Rotation Degrees : [ None - I Quick

Image Control Options

Split Image: [ None 7 I

Flip Side Rotation

D

@) Book Fanfald

Image Control Options

[F] Mirrar

o=
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Rotate
Image

Choose the rotation angle from the drop down
list if you wish to rotate your scanned image.

Choice: None, 90°CW((clockwise),
90°CCW (counter clockwise), 180°, Auto
based on contents. Auto rotate every
even page.

123 —

()
I
Original Rotate 90°CW
N
o~ ¢C1
—
Rotate 90°CCW Rotate 180°

Auto based on contents: Automatically
rotate images based on the contents of
document. When " Auto based on
contents | is selected, its modes will be
enabled to let you select more options.

Mode: Quick, Full Text, Complexity

Quick — the default mode to let you rotate
images at the fastest speed.

Full Text — the enhanced mode for
documents with mixed text orientation.

Complexity — the enhanced mode yet at the
slowest speed for document with complex
image or text orientation.
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Auto rotate every even page:
Automatically rotate 180° on every even
page. This is especially useful when you scan
the inside pages from a book. As a result, if
you choose “Flatbed (book)” from the “Scan
Source” option, “auto rotate every even page”
will be selected as default.

Note: This option varies based on type of
scannetr.

Document with various Document with dark or
text orientations complex background
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Split
Image

By splitting an image, two separate images are
created horizontally or vertically. This is useful
for documents containing two pages per image
when you want to save them as two images
(one page for one image). Choice: None,
Horizontal, Vertical. Default is None.

Horizontal: Divide one image into the upper
half and the lower half.

Vertical: Divide one image into the left half and
the right half.

B Ty
Y
Split Horizontally Split Vertical
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Flip Side Select “fanfold” to rotate the image of the
Rotation reverse side to 180 degrees.

This is applied to double-sided document
which are viewed in portrait are sometime
fed into the scanner in landscape or vice
versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of the
reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

4
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Image Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

- B .
The Mirror

ffe ct
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4.11 The Separation Tab

The Separation tab allows you to enable the detection engine to
detect the blank page, barcode, and patch code and then notify
the software application which supports document separation to
separate your multi-page documents. Choices: Blank Page
Removal, Barcode Detection, Patch Code Detection.

.+ Scanner Properties ==l

[ Image | Paper | MutiFeed Detection | Preview | Rotation | Separation | Enhancement | Setting | Information |

Elank Page Removal

[ Blank Page Removal Threshold:
Barcode Detection

[7] Enable

Paich code Detection

7] Enable

Defauls oK

Blank Page Choices: None, Blank Page Removal Threshold,

Removal Image Size.
None — Do not remove the blank pages.
Threshold - Move the slider to the left or right
to define your threshold for the blank page.
Image Size — Range: 1~ 10000 KB. Specify
your desired image size to detect the page as a
blank page. For example, if 3 KB is selected,
any page less than 3 KB will be recognized as
blank page.
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When the bar code has been detected successfully - a file
[avbarcode.ini] will be created and stored in the following path:

Windows XP: C:\Documents and Settings\All Users\Application
Data\% PRODUCTNAME%

Vista, Windows 7, Windows 8, Windows 10:
C:\ProgramData\% PRODUCTNAME%

Barcode Detection:

Check [Enable] to detect barcode and notify the software
application for advanced processing. Please note the whole
document will be checked and no specific detection area needs
to be designated.

Barcode Types:
The following barcode types can be detected.

Two-dimensional codes

e Aztec

e DataMatrix
e PDF417

e QR Code

One-dimensional barcodes:
Add-2

Add-5

Airline 2 of 5

Australian Post 4-State Code
BCD Matrix

Codabar

Code 128 (A,B,C)

Code 2 of 5

Code 32

Code 39

Code 39 Extended

Code 93

Code 93 Extended
Datalogic 2 of 5
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EAN 128 (GS1, UCQ)
EAN-13

EAN-8

GS1 DataBar
Industrial 2 of 5
Intelligent Mail (One Code)
Interleaved 2 of 5
Inverted 2 of 5
ITF-14 / SCC-14
Matrix 2 of 5

Patch Codes

PostNet

Royal Mail (RM4SCCQC)
UCC 128

UPC-A

UPC-E

Barcode Zone:
Specify the barcode zone to be detected.

Select TAIll , to checks the whole document and detects

barcodes. Or you may speed up the process by specifying a
detection area since only the specified area is checked.

Choice: All, Top, Bottom, Left, Right, Bottom Right,
Bottom Left, Top Right, Top Left
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Choice for barcode zone on a page:

AII

Top Bottom Left Right

Bottom Bottom Top Right | Top Left
Right Left

NOTE:

Recommended resolution: 200~ 600 dpi for regular

barcode, 300~ 600 dpi for QR code.

Skewed barcodes may not be recognized correctly.

Using the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the

sheets. If the sheet is not recognized correctly or gets
smudged, replace it with a new sheet.

Patch code Detection:
Check [Enable] to detect patch codes and notify the software
application for advanced processing.

A patch code is a pattern of parallel, alternating black bars and
spaces (i.e. a barcode) that is printed on a document. Patch
code sheet is most commonly used as a document separator in
a stack of document.
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You can find various sizes of patch codes (PDF) by choosing
[Start] menu>[All Programs]>[Avision Scanner
Series]>[Patch code] in succession.

Simply print the PDF file to produce the patch code sheet.
Insert the patch code sheets to wherever you want the file to
separate.

Patch code sheet

NOTES TO PRINT THE PATCH CODES:

Use blank white paper.

Set the scaling to 100%. The sheet is not recognized
correctly when printed in a size smaller than the
original.

Do not use toner saving mode. The sheet is not
recognized correctly when the print is too light.

Do not use thin paper in order to avoid bleed-through
from the back.

When you copy a patch code sheet that you printed
out, make sure to copy by the same size and
brightness as the original copy.

Use the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the
sheets. If the sheet is not recognized correctly or gets
smudged, replace it with a new sheet.
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4.12 The Setting Tab

The Setting tab allows you to set the following settings:

23 Scanner Properties =
[image [ Pepar | Setting [information]|
Cache
Mode [Memory Sizs -
Memry Size: e b Defaut
Energy Saving Control
Enable Enengy Saver Y= 15 minutes
-
BLE] (V) Enable Power OF « ] b 240 mintes
[#] Show Scanning Progress Tabs.
= |1 Compression
V] v V
[7] Show Waming Message |5 Colr Dropout
T3 Muti-Feed Detection
= |1 Preview
[7] Eiect Paper Opposte |7 Fatton
|1 Separation
|0 Enhancement
|1 mprter

The Setting tab dialog box

Energy Saving Check the Enable Energy Saver box

Control and move the slider to set the amount
of time to start the energy saver after
your last action. The range is from 1 to
240 minutes. The default value is 15

minutes.
Enable Power Check the Enable Power Off box and
Off move the slider to set the amount of

time to automatically turn off the
scanner after your last action. The
range is from 1 to 480 minutes. The
default is 240 minutes (4 hours). Note
the value of “Power Off” has to be
greater than or equal to the value of
“Energy Saving”.
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Cache Mode: None, Page Number, Memory
Size.
This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to
process the image data especially when you
have a large amount of documents needed
to be scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

1N

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.

Show Check and the scanning progress bar will
Scanning be shown during scanning.
Progress

xog Bojeiq seipedold Jsuueog ay; Buisn
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Show Warning
Message

Save Settings
after Closing

Check to show the warning messages
such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Check to save your scanner properties
settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.13 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters,
date, time, document count and custom message on your
scanned image if digital imprinter is selected or at the back of
your document if external imprinter is selected.

23 Scanner Properties
| image | Paper | Setting | Imprinter | information |
[] Digttal Imprirter
Content
Prirt All
1 L None 4
Normal
Advanced Print Position 4
Momal st Middle
Nomal
Sample
noo1

Choice: External I mprinter, Digital Imprinter. If you have
installed an external imprinter, choose external imprinter. If
you do not have an imprinter, choose digital imprinter. Note
External Imprinter provides a vertical and rear-side print
capability while digital printer provides a horizontal and front-
side print capability.

xog bojeiq saiedoid Jeuuesg ayy buisn
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Contents

Print All Check Print All to automatically print the
text at all pages of your documents.
Uncheck Print All to print the text for the
first page of your documents only.

Custom Enter your custom text to be included in your
print string.

Counter Show the document count for the scan

session. This value is increased sequentially
by the scanner.

Date/ Time  Choose if you wish to include the date and
time in your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year,
month, date, hour, seconds, your custom
text and the counter.

Custom Choose your desired font.
Font Choice: Normal, Fixed Width

Fixed Width (Mono spaced) fonts have a
fixed character spacing. So each character
occupies the same width.

Advanced

Font Choose your font attributes. Choice:
Attributes Normal, Underline, Double, and Bold.
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String Choose your string orientation.

Orientation Choice: Normal, Rotated, Vertical,
Vertical Inversion, 90 degrees CW, 90
degrees CCW

2qeQlLoc
2010abc

=
o
°
3
2

Rotated

OO0k
NOoO—Omilo

Vertical Vertical I nversion

24eQ 10¢
2010abc

90 degrees CW 90 degrees CCW

If you check the digital imprinter to stamp
text on your scanned image, the illustration of
normal and rotated string is shown below:

2010abc 9qeQloc
Rotated

xog bojeiq senadold Jauueosg ayj buisn
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Print Choose the position you wish to print your

Position string. Move the slider to the right to increase
the value or to the left to decrease the value.
Range: 0~355mm, default:0 mm
The value indicates the height from the
bottom of your paper to the last letter of your
string. This option is available only if an
external imprinter is installed.

0102 99e 1000

| The value of
Print Position

|

Print Position (for digital imprinter)

Choose the position of your printed string. Choice: Top,
Middle, Bottom, Custom. If Custom is selected, enter the X
and Y offset value to specify the position.
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4.14 The Information Tab

The Information tab displays the following system and scanner
information.

-2 Scanner Properties @
erage | Paper IEBBE‘ Impnrﬂe(l Information

Infia

CEl IFlailR) Core T 132120 CPU @ 33061z =

RAM: 1023 MB I

0s Microsoft Windows 7 Erterprise Service Pack 1 (Build 7601)

1S i Erfish (Urdsd Siales)

Digk Drive Ficed drive C:\Total: 30717MBFree:10435MB

Fixed drive Y \Total: 102338MBFree:10541MB
Fixed drive Z\Total:102338MBFree:23211MB |

m

Free Disk Space 10435 MB

Application Name: Awision Capture Tool 16(19)
TWAIN Driver Version 6.11.032916

140 Driver Version: 0.9, 2016, 224

Port Type: USE

1D / Address Use

Optical Resolution: 600 dpi

1N

Scanner Model:

Serial Number: NO25 =
Repot...

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file [Windows XP:
C:\Documents and Settings\All Users\Application

Data\% PRODUCTNAME% ; Vista, Windows 7, Windows 8,
Windows 10: C:\ProgramData\% PRODUCTNAME% (C: system
drive)] will be generated. Please send this file to the nearest
service center for trouble shooting.

xog 6ojeiq saiadold Jauueoasg ayy buisn
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The “Reset Roller Count” button :

After scanning over a recommended number of pages (refer to
subsequent section 7.4 Replacing the ADF Roller) through the
ADF, the ADF roller may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF roller with a new one. (Note
the replacement of the ADF roller has to be performed only by
authorized service center. Therefore, please return your
scanner for roller replacement.) After replacing the ADF roller,
click the “Reset Roller Count” button to reset the roller count.

NOTE:
' The lifetime and the replacing procedure vary based on
® type of scanner.
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5. ISIS Interface Operation

* Please refer to the preceding chapter, Scanner Installation, to
install ISIS scanner driver. You may start your ISIS-compliant
software application to scan via the ISIS user interface.

The ISIS driver operation method is similar to the TWAIN’s.
Every function on the ISIS interface screen is briefly described
as below:

Scanner Seftings

[Black and White v] | & Manual s

My | apwm ||
Cancel

Daken |  Nom | Lighten |

Brea..

Page Size: LContrast
|48 - 148 521.00m =] | F Maal O

PIXDFLT Yersion 55.1.250.851 S I [ | I
Awision PN Driver W2.01.062402

Mode: Select one of scan modes, including B&W, gray, color
options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the lightest
shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using the Buttons

The following picture shows the 4 buttons and 1 function
screen on the scanner.

Function 2
Function Screen Function-Select
v L Button

—— Cancel Button
_ Scan Button

6.1 Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.
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6.2 Checking the Button Configurations before Scanning

1.

Button Manager V2 runs from the system tray. After Button
Manager V2 and the scanner driver are properly installed,
Button Manager V2 is started and the Button icon will be
displayed on the system tray at the bottom right corner of
your computer screen.

01:41 Ph

Left-click the Button Manager V2 icon to prompt the
following Button Panel.

E This indicates the scanner model

l E:_.:‘: iScan (Image) 1
I E iScan (OCR)
1‘5 —  The Function
1 Scan Todpp lcon
) (The number of
E} E-hlail function icons
= vary based on
!@ Printer — type of
= scanner.)

The Button 4y @ EF L1145

lcon

The Button Panel
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

Name of the Selected Button

Basic | Image Adfustment || Color Dropont | Image Processing | Mare Settings
Button —
B aramet:
Name ﬂ iScan (OCR) ] s
= Resolution(dpi) 300

Tmage bode Ee :| -
Im age Mode [m ) Auto FPaper Size: |Amu Crop & Deskew kY |
Selection [ OCeol: [ Dplex Basic Scan
Box [ ©Tmy Parameters

0 ©) Black and White Advanced Settings: []Use TWAIN
Folder and bl leettem
file name Divectory: |C:\Docu.ment3 and Settingsvoid My Dacumentsiby P].ctu.'res| [ Browss ]
for the Fe Name: | Lmage_#HHHE | [ More. ]
scanned ! g
. File Format: | OCE(For iScan Cily) v |
image c

Destination: | 5 ifean v | [}
Scan To Descripti o licati and i the d 1 ditable (g

. . — escription: pen your application, scan nsert scanned fage or editable text
destination (after OCR) directly to your application. —
and settings 4
oY)
00k Lo S Conn: © <
—
OCR QCE Zaone: Eeyword: l:l g
in

sett gs Wo. of Recognized Charscters After Keyrwond |:| @

If you wish to change the setting, use this window to reset
the setting for the file format, destination application, or
other scan settings.

4. Click the OK button to leave the window.
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6.3 Scanning From One Touch of the Buttons

1.

2.

Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document feeder.
Check the button name on the LCD screen to ensure if you
are selecting the proper scan settings and destination
application. (For example, if you wish to scan with Button,
“Scan to App”, which opens Microsoft Paint and displays the
scanned image in the window of Microsoft Paint, the LCD
screen should show “Scan to App”).

Press the Scan button on the scanner.

After the scanning is finished, the Microsoft Paint software
will be launched and the scanned image appears in the main
window of Microsoft Paint as below.

|__ADF min. paper size.
| ADFmax piparsiza
Flatbed max. paper size

S o

NOTE:
For details information on how to use the Button Manager
V2, please refer to the user’s manual in the supplied CD.
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7. Maintenance

7.1 Cleaning the ADF

From time to time, the Reverse roller and the Feeding Rollers
may be contaminated with ink, toner particles, or paper dust.
In this case, the paper may not be fed smoothly. Please follow
the following steps to clean the Reverse roller and the Feeding
Rollers to ensure the best of the scanner.

The Cleaning Steps:

1. Soak a clean cloth with some isopropyl alcohol (95%).
2. Press the ADF release button and open the front door.
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Wipe the feeding rollers until they are cleaned.

3.

Press both sides of the cover of the ADF reverse roller and

pull the cover down.

4.
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7.2 Cleaning the Glass

1.
2.
3

Press the ADF release button. Open the front door.

Wet a clean cloth with some isopropyl alcohol. (95%)

Wipe the glass as illustrated below by moving the swab from
side to side to rid the dust or dirt.

7-3
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7.3 Replacing the ADF Reverse Roller

After scanning approximately 100,000 pages through the ADF,
the reverse roller will be worn out and you may have problems
with document feeding. It is time to replace the Reverse roller.
For ordering the replacement, please contact your dealer.

Disassembling Procedure

1. Press the ADF release button.
2. Gently open the ADF front door to the left.

3. Hold the reverse roller cover with your fingers as shown and
place it down.
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4. Press the right end of the reverse roller externally to detach
it from the slot and then detach the left end from its hole.

|
= —
L o= i
A .
Reassembling Procedure
1. Insert the left end of the reverse roller to the hole of its
original place.
2. Insert the right end of the reverse roller to its slot.

7-5
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@L“@,{m : 7

3. Close the reverse roller Cover.

4. Close the ADF cover.
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7.4 Replacing the ADF Roller

After scanning approximately 200,000 pages through the ADF,
the ADF roller may be worn out and you may experience
problems with document feeding. In this case, you may need to
replace a new ADF roller. For ordering the ADF roller, please
consult your nearest dealer and follow the procedure below to
replace it.

Disassembling Procedure

1. Press the ADF release button to open the front door.

2. Pull the center of the roller cover to open it.
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3.

Move the tab of the ADF roller DOWN as indicated.

i |

-

Detach the right end of the ADF roller from the slot and
remove the ADF roller.
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Assembling Procedure

1. Insert the left end of the ADF roller first to its slot and place
the ADF roller to its proper position.

Make sure the belt in the center of the ADF roller is installed
horizontally with the other rollers as indicated.

I

The Belt

L]

2. Move the tab of the ADF roller UP.
<

LA ESE)

— i —— —
O o O ) oA ‘\__

|_"_i|

3. Close the ADF roller cover. A snap-in sound could be heard if
correctly installed.
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8. Troubleshooting

8.1 Clearing a Paper Jam

In the event of a paper jam, follow the procedures below to
remove the paper:

1. Press the ADF release button on the right side. Gently
open the front door.

2. Carefully pull the paper out of the ADF unit.
3. Close the front door. Your Scanner is now ready to use.

8-1


https://manualsfile.com

User’s Manual

8.2 Questions and Answers

Question:

Answer:

Question:

Answer:

Question:

Answer:

Paper becomes jammed during
scanning.

1) Open the front door.

2) Pull out the jammed paper carefully.
3) Close the front door.

More than one sheet of paper are

fed into the scanner.

1) Open the scanner front door.

2) Remove the multi-fed sheets.

3) Close the front door.

4) Flatten the corners and edges.
Loosen the paper before putting it
into the paper guide again.

5) Check the feeding roller condition.
If necessary, follow the cleaning
directions in section 7.1 and
perform the cleaning.

Paper becomes skewed in the

scanner.

1) Use the slide guide to keep the
paper path straight.

2) Check the condition of the feeding
roller. If necessary, follow the
cleaning directions in Section 7.1
and perform the cleaning.

8-2


https://manualsfile.com

User’s Manual

Question: Why does my scanned image

always come out too dark?
Answer: 1) Please adjust the screen settings to
sRGB.
2) Please adjust the brightness
settings on the screen from
application software.

When | choose optical resolution

Question: 4
to be 600 dpi, the "auto crop" and 5]

"deskew" functions will be S

disabled. 8

Answer: Since to perform auto crop and deskew §-
consumes great deal of system =

«Q

memory, it is suggested if you wish to
perform "auto crop” and "deskew"
functions, please choose your optical
resolution to be smaller than 600 dpi
to prevent a error message.
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8.3 Technical Service

Before contacting Avision, please prepare the following
information by referring to Section 4.14, The Information Tab:

m Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision I nc.

No. 20, Creation Road |, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, I nc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com

8-4


https://manualsfile.com

User’s Manual

China Area
Shanghai Technical Support Center

7A, No.1010, Kaixuan Road, Shanghai 200052 P.R.C.

TEL :+86-21-62816680

FAX :+86-21-62818856

E-MAIL :sales@avision.net.cn

Web Site:http://www.avision.com.cn

Europe Area

Avision Europe GmbH

Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40

FAX: +49-2151-56981-42

E-MAIL: info@avision-europe.com

Web Site: http://www.avision.de

Espaco Brasil

Avision Brasil Ltda.

Avenida Jabaquara, 2958 - Cj. 75 - Mirandopolis —
CEP: 04046-500 - Sao Paulo, Brasil

TEL: +55-11-2737-6062

E-MAIL: suporte@avisionbrasil.com.br

Web Site: http://www.avisionbrasil.com.br
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9. Specifications

All specifications are subject to change without notice. For
the most up-to-date and detailed specifications, please refer to
our web site at http://www.avision.com

Model Number :
Optical Resolution:
Scanning Modes:

ADF Capacity:

Max. Document Size:
Min. Document Size:
Paper Weight:

ID Card Thickness:
Interface:

Power Source:

Operating Temperature:

Dimensions: (WxDxH)
Min.

Max.

Weight:

FL-1602B

600 dpi

Black & White

Gray

Color

Up to 80 pages (70 g/m?) (20 Ib.)
216 x 356 mm (8.5 x 14 in.)
50 x 50 mm (2 x 2 in.)

27 ~ 413 g/m? (7 ~ 110 Ib.)
<1.25 mm (0.05 in.)
Hi-speed USB 2.0

24V, 2.0A

102C~35°C

316 x 191 x 168 mm
(12.4 x 7.5 x 6.6 in.)
316 x 680 x 239 mm
(12.4 x 26.8 x 9.4 in.)

3.9 kg (8.6 Ib.)
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